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Introduction to Mauve

Genomes evolve

Over the course of evolution, genomes can undergo many small and large-scale changes. Local changes such as nuclectide
substitution and indels have been observed in comparative studies of individual genes. Recombination, however, can cause
large-scal e changes such as gene loss, duplication, rearrangement, and horizontal transfer. Understanding the rates and patterns of
each type of change is expected to yield insights into various biological processes.

Genome Alignment - A means for comparison

The advent of genome sequencing provides the data needed to characterize rates and patterns of genome evolution. Genome
alignments can identify evolutionary changesin the DNA by aligning homologous regions of sequence. Mauve is a software
package that attempts to align orthologous and xenologous regions among two or more genome seguences that have undergone
both local and large-scale changes.

Locally Collinear Blocks

Because recombination can cause genome rearrangements, orthologous regions of one genome may be reordered or inverted
relative to another genome. During the alignment process, Mauve identifies conserved segments that appear to be internally free
from genome rearrangements. Such regions are referred to as Locally Collinear Blocks (LCBS).

The original Mauve algorithm

This section gives a brief working overview of the Mauve algorithm. For more detail, please see the paper Mauve: Multiple
Alignment of Conserved Genomic Sequence with Rearrangements that appears in Genome Research .

Anchored alignment

Like many other genome alignment methods, Mauve uses the anchored alignment technique to rapidly align genomes. Unlike most
genome alignment methods however, Mauve allows the order of alignment anchors to be rearranged in each genome permitting
identification of genome rearrangements.

Finding anchors

The current Mauve release uses inexact, ungapped matches as alignment anchors. The inexact matches are found using a
seed-and-extend method, where each seed match conforms to a pattern of matching nucleotides. The inexact seed matching
paradigm has previously been described by Ma. et. a 2002 . Mauve extends the pairwise seed matching paradigm to match multiple
sequences simultaneously under the constraint that any seed must be unique in each genome. In order to be considered an anchor,
the fully extended match must cover some minimum number of nucleotides. The minimum match length is user-definable, and
Mauve has a default value that automatically adjusts for the size of genomes being aligned.

Selecting Locally Collinear Blocks (LCBS)

Among the initial set of anchorsidentified by Mauve, some will be random matches that should not be included in the correct
genome alignment. Such random matches typically appear as small, insignificant genome rearrangements. In order to identify and
discard such matches, Mauve requires that each collinear region of the alignment meets a"minimum weight" criteria. The weight of
an LCB is defined as the sum of the lengths of matches in that LCB. Mauve removes matches composing low-weight LCBs from
the set of aignment anchors before completing the alignment. The minimum LCB weight is a user-definable parameter, and by
default Mauve chooses this value to be 3 times the minimum match size.

Finishing the alignment

Once a set of alignment anchors that define Locally Collinear Blocks have been determined, Mauve can compl ete a gapped global
alignment of each LCB. Mauve applies the ClustalW progressive global alignment algorithm to each LCB.

Limitations of the original Mauve algorithm

* Mauve works best on closely-related organisms (like E. coli and Salmonella or Y. pestis)
* Large regions shared by subsets of the genomes are not aligned
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* Rearranged regions shared by subsets of the genomes will not be identified
* The minimum LCB weight must be manually determined for accurate estimation of genomic rearrangement
* |t has difficulty aligning genomes with vast amounts of segmental duplication

The Progressive Mauve agorithm: addressing limitations of the original algorithm

Comparative genomics has revealed that closely-related bacteria often have highly divergent gene content. While the original
Mauve algorithm could align regions conserved among all organisms, the portion of the genome conserved among all taxa (the
core genome) shrinks as more taxa are added to the analysis. As such, the original Mauve algorithm did not scale well to large
numbers of taxa because it could not align regions conserved among subsets of the genomes under study. Progressive Mauve
employs a different algorithmic approach to scoring alignments that allows alignment of segments conserved among subsets of
taxa. The Progressive Mauve algorithm has been described in Aaron Darling's Ph.D. Thesis, and is also the subject of a manuscript
under review. A brief overview isgiven here.

Finding initial local multiple alignments

Progressive Mauve elaborates on the original algorithm for finding local multiple alignments. Instead of using a single seed pattern
for match filtration, Progressive Mauve uses a combination of three seed patterns for improved sensitivity. The palindromic seed
patterns have been described in Darling et al. 2006 "Procrastination leads to efficient filtration for local multiple alignment"

Seed matches which represent a unique subsequence shared by two or more input genomes are subjected to ungapped extension
until the seed pattern no longer matches. Theresult is an ungapped local multiple alignment with at most one component from each
of the input genome sequences.

Computing a pairwise genome content distance matrix and guide tree

Progressive Mauve builds up genome alignments progressively according to aguide tree. The guide tree is computed based on an
estimate of the shared gene content among each pair of input genomes. For a pair of input genomes, gx and gy, shared gene content
is estimated by counting the number of nucleotidesin gx and gy aligned to each other in the initia set of local multiple alignments.
The count is normalized to a similarity value between 0 and 1 by dividing by the average size of gx and gy. The similarity valueis
subtracted from 1 to arrive at adistance estimate. Neighbor joining is then applied to the matrix of distance estimatesto yield a
guide tree topology. Note that the guide tree is not intended to be a phylogeny indicative of the genealogy of input genomes. Itis
merely a computational crutch for progressive genome alignment. Also note that alignments are later refined independently of a
single guide tree toplogy to avoid biasing later phylogenetic inference.

Computing a pairwise breakpoint distance matrix

Prior to alignment, Progressive Mauve attempts to compute a conservative estimate of the number of rearrangement breakpoints
among any pair of genomes. For each pair of genomes, pairwise alignments are created from the local-multiple alignments and the
pairwise alignments are subjected to greedy breakpoint elimination. The breakpoint penalty used for greedy breakpoint elimination
is set high for closely related genomes and scaled downward according to the estimate of genomic content distance. Because the
breakpoint penalty is high, the resulting set of locally collinear blocks represent robustly supported segmental homology, and a
conservative estimate of the breakpoint distance can be made on thisbasis. The conservative estimate of breakpoint distanceis
used later during progressive alignment to scale breakpoint penalties.

Progressive genome alignment

A genome alignment is progressively built up according to the guide tree. At each step of the progressive genome alignment,
alignment anchors are selected from the initial set of local multiple alignments. Anchors are selected so that they maximize a
Sum-of-pairs scoring scheme which applies a penalty for predicting breakpoints among any pair of genomes. Because rates of
genomic rearrangement are highly variable, especially in some bacterial pathogens, some genomes may be expected to exhibit
greater rearrangement than others. As such, asingle choice of scoring penalty is unlikely to yield accurate alignments for all
genomes. To cope with this phenomenon, Progressive Mauve scal es the breakpoint penalty according to the expected level of
sequence divergence and the number of well-supported genomic rearrangements among the pair of input genomes. These scaling
values are taken from the distance matrices computed earlier in the algorithm.

Anchored alignment

Once anchors have been computed at a node in the guide tree, aglobal alignment is computed on the basis of the anchors. Given a
set of anchors among two genomes, a genome and an alignment, or apair of alignments, a modified MUSCLE global alignment
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algorithm is applied to compute an anchored profile-profile alignment. MUSCLE isthen used to perform tree-independent iterative
refinement on the global genome alignment.

Rejecting alignment of unrelated sequence

Although we compute a global alignment among sequences, genomes often contain lineage-specific sequence and are thus not
globally related. The global alignment will often contain forced alignment of unrelated sequence. A simple hidden Markov model
structureis used to detect forced alignment of unrelated sequence, which are then removed from the alignment.

Strengths of the Progressive Mauve algorithm

* |t can be applied to a much larger number of genomes than the original Mauve algorithm

* |t can align more divergent genomes than the original algorithm. Genomes with less than 50% nuclectide identity are often
alignable

* Manual adjustment of the alignment scoring parametersis usually not necessary
* |t aligns regions conserved among subsets of the input genomes

Limitations of the Progressive Mauve algorithm

* |t is substantially slower than the original Mauve agorithm
* |t consumes more memory than the original Mauve algorithm
* Manual adjustment of the breakpoint penalty may still be required
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Installing Mauve

Installing and Running Mauve

Whether Mauve will be running under Windows, Linux, Mac OS X, or another operating system, it requires Javaversion 1.4 or
later. Many systems already have Java 1.4 installed, so this will not be a concern. The Windows version of Mauve includes the Java
installer for 32-bit windows systems that don't already have it. On other systems Java may need to be installed separately.

Downloading

Download the latest version of Mauve for your operating system from  http://gel.ahabs.wisc.edu/mauve/download.php .

Installation on Windows

Installing

Run the Mauve installer that has been downloaded. Click the "Next" button several times. If you do not aready have Java 1.4 or
later and your computer runs 32-bit Windows, the Mauve installer will offer to start the Javainstaller for you. If your computer
uses 64-bit Windows, you will need to download and install the 64-bit Java Runtime Environment from Sun's Java web site.

Running

After installation, Mauve will appear in your system's Start Menu. To run Mauve simply select it from the Start Menu.
Alternatively, the command-line mauveAl i gner and pr ogr essi veMauve programs may be run from the directory where
Mauve was installed. See the chapter on command-line execution for more details.

Installation on Mac OS X
Installing

Download the Mauve disk image and copy the Mauve application to your "Applications’ folder or another folder of your choice.

Running
Easy. Double-click the Mauve application.

Installation on Linux

Prerequisites

The Linux version is compiled for 32-bit and 64-bit x86 architecture and will only run on such hardware. Mauve can be built
from source code to run on other architectures. Mauve requires the Sun Java runtime environment to work properly. The GNU gcj
javaruntime environment, which is the default environment on linux distributions such as Fedora, Red Hat and others, may work
but is not supported. Please download and install a Sun java runtime environment for your system.

Configuring

If javais not in the executabl e path, the Mauve script may need to be edited to point to the Javainstallation. Once downloaded and
uncompressed, edit the file Mauve by changing the variable JAVA_CNMD to contain the full path to the java executable.

Running

Simply run . / Mauve from within the Mauve directory to start the Mauve Java GUI. Alternatively, the command-line alignment
programs mauveAl i gner and pr ogr essi veMauve can be used and provide more flexibility than the Mauve GUI. Y ou may
want to add the directory containing Mauve to your executable path.

Other Unix-like operating systems

Although we only provide pre-compiled binary distributions of Mauve for Windows, Linux, and Mac OS X, we do make the
source code for the Mauve GUI and mauveAligner available. If the mauveAligner source code can be compiled on a system, then
the compiled binary can be used as a drop-in replacement for the mauveAligner binary distributed with the Linux version of Mauve.
Mauve should then behave just asit does under Linux.
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Constructing a Genome Alignment

Mauve provides a simple user interface for aligning genomes. Once Mauve has started up, simply select "Align..." or "Align with
progressiveMauve..." from the "File" menu.

&+ Mauve 2.1.0al - Genome Alignment Yisualization i [m] A

File | View Help

Open... Ctrl-0
Align...

Align with progressiveMauve...

Prip= - T "
= Align sequences with progressiveMacye (slower, mare Sen5|twe}...|
Page Setup...

Print Preview Chrl+Shitt-P
Export Image... Ctrl-E
Close Ctrl-ny
Guit Ctrl-2

Mauve then presents the alignment dialog box:
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i

_Files rParameters |

Sequences to align:

C:shigellaiNC_000913.gbk
C:shigella\NC_004337.gbk
C:shigellaiNC_004741.gbk

Add Sequence... | | Remove Sequence |

Output File: | []

Align...

The following sections describe the various entry fields in the dialog box.

Using the alignment dialog box

Sequence file input formats

Genome sequence files can be given to Mauve in any of FastA, Multi-FastA, GenBank flat file, or raw formats. Mauve deduces the
file format based on the file name extension. By default, afile with any unrecognized file name extension is assumed to bein
(Multi-)FastA format. Extensions recognized by Mauve are .gbk (GenBank), and .raw (raw sequence data). Note that some very old
versions of Mauve (up to 20040219) also assume that .txt filesare in raw format. FastA and GenBank format files with the genome
of your organism can usually be downloaded from NCBI at ftp://ftp.ncbi.nih.gov/genomes The .fhafilesarein FastA format and
the .gbk files are in GenBank format. For genomes with plasmids, mutliple .fna or .gbk files may need to be downloaded and
concatenated into asinglefile.

When an individual file contains several sequence entries, they will be concatenated and the whole concatenated sequence will be
aligned to the sequencesin the other files. This behavior allows multi-chromosomal genomes to be aligned by including all
chromosomes in a single sequence file. Similarly, incomplete genomes that consist of several sequence contigs can be aigned,
though beware that incorrectly ordered contigs will appear as genome rearrangements in the Mauve viewer.

Alternatively a single Multi-FastA file containing all the genomes to align can be specified. In this case Mauve assumes one
genome per Multi-FastA sequence entry and will align the entries to each other.

Selecting Genomesto align

The top entry area lists the sequence file(s) containing the genomes that will be aligned. To add a sequence file, click the"Add
sequence...” button and select the file to add. The Windows version of Mauve supports Drag-and-drop, allowing sequence filesto
be added by dragging them in from the windows explorer.

Setting an output location

The location where Mauve stores its alignment results can be set using the "File output:" text entry field. If left blank, Mauve will
prompt for an output file location.

Setting custom alignment parameters

The alignment parameters are different between original Mauve (mauveAligner) and Progressive Mauve, and are discussed in more
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detail in alater section.

Computing the alignment

Once the genome sequences have been loaded, click the "Align..." button to start the alignment. A console dialog will appear and
will show the progress being made towards completing the alignment.

EMauve Console

Clear Save Close

Cancel arunning alignment

Asof version 2.1.0, it is possible to cancel a running alignment by returning to the "Align sequences..." dialog box and clicking the
"Cancel alignment" button. Alternatively, quitting the Mauve program should also kill the running alignment. If al elsefails, the
running aligner (mauveAligner or progressiveMauve) can be killed using the Windows task manager, the Mac OS X process
inspector, or the 'kill' command in unix.

Original Mauve (mauveAligner) alignment parameters

By default, Mauve selects a set of alignment parameters that are appropriate for aligning closely related genomes with moderate to
high amounts of genome rearrangement. However, some alignment parameters can (and should!) be adjusted to change Mauve's
behavior. For example, the default value for Minimum LCB weight is often too low and should be replaced with a manually chosen
value. When aigning more divergent genomes, the seed size can be reduced to find additional alignment anchors and achieve
greater alignment coverage over the genomes. Another option disables the full alignment process, allowing Mauve to quickly
generate a comparative picture of genome organization.
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_rx
Files | Parameters |

X,

Default seed weight
Determine LCBs Min LCB weight: |default

[ ] Assume collinear genomes

Full Alignment Aligner: |Mus-::|e 3.6 | -
Extend LCBs

Minimum Island Size:
Maximum Backbone Gap Size:

Minimum Backbone Size:

0l

Align...

The following sections describe the various entry fields in the dialog box.

Parameter descriptions:

Match seed weight

The seed size parameter sets the minimum weight of the seed pattern used to generate local multiple alignments (matches) during
the first pass of anchoring the alignment. When aligning divergent genomes or aligning more genomes simultaneously, lower seed
weights may provide better sensitivity. However, because Mauve & so requires the matching seeds must to be unique in each
genome, setting this value too low will reduce sensitivity.

Default seed weight

Setting this option will allow Mauve to select an initial match seed weight that is appropriate for the length of sequences being
aligned. The default seed size for IMB genomesistypically around 11, is around 15 for SMB genomes, and continues to grow with
the size of the genomes being aligned. The defaults may be conservative (too large), especially when aligning more divergent
genomes. On the other hand, higher seed weights reduce noisy matching and can lead to better alignment in some cases.

Min LCB Weight

The LCB weight sets the minimum number of matching nucleotides identified in a collinear region for that region to be considered
true homology versus random similarity. Mauve uses an algorithm called greedy breakpoint elimination to compute a set of Locally
Collinear Blocks (LCBs) that have the given minimum weight. By default an LCB weight of 3 times the seed size will be used.
The default value is often too low, however, and this value should be set manually. The procedure to determine a reasonable value
for the Min LCB Weight usually involves constructing an initial alignment with the default value, and then using the LCB weight
dlider in the Mauve GUI (see the next section) to find aweight that eliminates all spurious rearrangements. The sequences can then
be realigned using the manually determined weight value.

Determine LCBs
If this option is disabled Mauve will simply identify matches (local multiple alignments) among the genomes. See the description of
match generation in the command-line interface chapter.

Extend LCBs
Controls whether mauveAligner will attempt to extend the range of existing LCBs and search for additional LCBs. For some

datasets, LCB extension can be very time-consuming and may not offer much improvement in the alignment.

Assume collinear genomes
Select thisoption if it is certain that there are no rearrangements among the genomes to be aligned. Using this option when aligning
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collinear genomes can result in improved alignment accuracy.

Aligner
Sets whether mauveAligner will utilize MUSCLE or Clustal W to compute global alignments between alignment anchors.
MUSCLE isthe preferred choice, sinceit is faster and more accurate.

Island and Backbone sizes

Anisland isaregion of the alignment where one genome has a sequence element that one or more others lack. This parameter sets
the alignment gap size used to calculate islands and backbone segments. See the description of the .islands and .backbone files
below for more information.

Full alignment

Selecting the "Full alignment” option causes Mauve to perform arecursive anchor search and a full gapped alignment of the
genome sequences using the ClustalW or MUSCLE progressive alignment method. If not selected, Mauve will identify LCBs but
will not do arecursive anchor search or progressive alignment.

Progressive Mauve alignment parameters

By default, Mauve selects a set of alignment parameters that are appropriate for aligning closely related genomes with moderate to
high amounts of genome rearrangement. However, some alignment parameters can (and should!) be adjusted to change Mauve's
behavior. For example, the default value for Minimum LCB weight is often too low and should be replaced with amanually chosen

value. When aligning
i
Files | Parameters |

Default seed weight

Use seed families ()
Determine LCBs

[ ] Assume collinear genomes

Full Alignment Min LCB weight: |default
lterative refinement

Sum-of-pairs LCB scoring

Align...

Match seed weight

As with mauveAligner, the seed size parameter sets the minimum weight of the seed pattern used to generate local multiple
alignments (matches) during the first pass of anchoring the alignment. When aligning divergent genomes or aligning more genomes
simultaneously, lower seed weights may provide better sensitivity. However, because Mauve a so requires the matching seeds must
to be unique in each genome, setting this value too low will reduce sensitivity.

Default seed weight

Setting this option will allow Mauve to select an initial match seed weight that is appropriate for the length of sequences being
aligned. The default seed size for IMB genomesis typically around 11, is around 15 for 5SMB genomes, and continues to grow with
the size of the genomes being aligned. The defaults may be conservative (too large), especially when aligning more divergent
genomes. On the other hand, higher seed weights reduce noisy matching and can lead to better alignment in some cases.

Use seed families
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Setting this option causes progressiveM auve to search for matches using three spaced seed patterns instead of just one. Using three
patterns can greatly improve sensitivity on diverged genomes, and permits using a higher seed weight for closely related organisms
without loss of sensitivity. Using seed families requires minor additional compute time in most cases.

Determine LCBs
If this option is disabled Mauve will simply identify matches (local multiple alignments) among the genomes. See the description of
match generation in the command-line interface chapter.

Assume collinear genomes
Select thisoption if it is certain that there are no rearrangements among the genomes to be aligned. Using this option when aligning
collinear genomes can speed up progressiveMauve's running time.

Full alignment and Iter ative Refinement

Selecting the "Full alignment" option causes Progressive Mauve to perform arecursive anchor search and a full gapped alignment
of the genome sequences using MUSCLE. [f not selected, Progressive Mauve will identify alignment anchors cluster them into
LCBsfinish thealignment. The "Iterative Refinement" option applies MUSCLE to refine theinitial alignment, often improving the
initial alignment. As MUSCLE performs tree-independent iterative refinement, this option should be used to avoid biasing
phylogenetic inference with asingle guide tree.

Sum-of-pairs LCB scoring

This option selects whether breakpoint penalties are applied among all pairs of extant sequences, or whether penalties are applied to
inferred ancestral gene-ordering. Since Progressive Mauve does not accurately infer ancestral gene orders, and even if it did, it
does not infer ancestral genome content, this option should be considered "experimental" and should only be disabled when
aligning collinear genomes.
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Using the Alignment Viewer

The display layout

The aignment display is organized into one horizontal "panel" per input genome sequence. Each genome's panel contains the name
of the genome sequence, a scale showing the sequence coordinates for that genome, and a single black horizontal center line.
Colored block outlines appear above and possibly below the center line. Each of these block outlines surrounds a region of the
genome sequence that aligned to part of another genome, and is presumably homologous and internally free from genomic
rearrangement. When ablock lies above the center line the aligned region isin the forward orientation relative to the first genome
sequence. Blocks below the center line indicate regions that align in the reverse complement (inverse) orientation. Regions outside
blocks lack detectable homology among the input genomes. Inside each block Mauve draws a similarity profile of the genome
sequence. The height of the similarity profile corresponds to the average level of conservation in that region of the genome
sequence. Areas that are completely white were not aligned and probably contain sequence elements specific to a particular
genome. The height of the similarity profileis calculated to be inversely proportional to the average alignment column entropy over
aregion of the alignment.

&4 Mauve 2.1.0 - threeway_example - |EI|1|
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Figure 1 (above) shows an alignment of E. coli K12 MG1655, S. flexneri 2a301, and S flexneri 2457T. Notice how inverted
regionsin the S flexneri are clearly depicted as blocks below a genome's center line. These three genomes were taken from the
NCBI FTP site and aligned with Progressive Mauve using default parameters, as described in the previous section.

In Figure 1, colored blocksin the first genome are connected by linesto similarly colored blocks in the second and third genomes.
These lines indicate which regions in each genome are homologous. Notice the crossing "X" pattern of lines, which happen to occur
in the vicinity of the predicted origin and terminus of replication in these organisms. When viewing genomes with complex
rearrangements, the LCB connecting lines can be confusing and they can be hidden (or made visible again) by typing Shift+L
(pressing shift and L simultaneously) or using the "View" menu.
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In the standard color scheme, the region of sequence covered by a colored block is entirely collinear and homol ogous among the
genomes. The boundaries of colored blocks usually indicate the breakpoints of genome rearrangement, unless sequence has been
gained or lost in the breakpoint region.

The Backbone color scheme

When an alignment has been computed with Progressive Mauve, adisplay modeis available that colors regions conserved among
all genomes differently than regions conserved among subsets of the genomes. We term regions conserved among all genomes as
"backbone," which are drawn in mauve color. Applying the color mode to the alignment of three E. coli and Shigella, and
disabling LCB outlinesin the "View->Style" menu yields:

& Mauve 2.1.0 - threeway_example - |EI|5|
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Figure 2 (above) shows the same alignment of E. coli K12 MG1655, S. flexneri 2a301, and S flexneri 2457T, but displayed with
different style settings. Parts of the similarity plot which are colored mauve are conserved among all three genomes, while portions
colored green are segments conserved only among the Shigella flexneri. Segments conserved among E. coli and S. flexneri 2457T
are colored brown, but are too small to notice in awhole-genome view (see below). The black box follows the mouse cursor and
highlights the homologous site in each genome. Clicking the similarity plot will line up orthologous regions

Zooming in on Annotated Features

If the aligned genome sequences were in GenBank files containing annotated features Mauve will display the annotated features
next to the sequence similarity profiles. For efficiency reasons, annotated features appear only when less than 1IMbp of sequenceis
being displayed. To zoom in on the alignment, either use the magnifying glass buttons from the toolbar, or use the keyboard
shortcuts Ctrl+Up to zoom in (press Control and up arrow key simultaneously) and Ctrl+Down to zoom out. Once viewing less
than 1Mbp of sequence, annotated CDS features show up as white boxes, tRNAs are green, rRNAs are red, and misc_RNA features
are blue. Mauve displays the /product qualifier when the mouse cursor is held over afeature. When afeatureis clicked, Mauve
shows a detailed listing of feature qualifiersin a popup window, in addition to a menu that links to the NCBI Entrez protein entry
corresponding to the gene.

Using the Alignment Viewer - Updated: 11 November 2009



Using the Alignment Viewer - Updated: 11 November 2009

=
IR ENEN NS

J 3810000 3520000 2830000 3540000 3850000 3860000 3570000

(

_ i
v 171 I:q]dj]:h]m I-ll_lr"_|_|_|l_|'_|_|l_|_ll rl_llJ"I_ll_ll_|I_II_I_LIl_I ihﬂq:DDADEHEﬂ]DG%D[

CDS [38519445,38531 28]
Escherichia coli K12 K-12 emrD multidrug efflux system prote

000 3860000 SB?I':IDDFEI//_/_SB&GB'EI‘U'/ 3830000 3900000 3810000 3820000

oo™ oo o T U A ogo

Shigella flexneri 2a str. 301

2830000 2840000 2850000 2860000 2870000 3ge0000 3800066

File View Help

A

£ %

&
R

]I:II]][I:I:II_I—H]]I:D”"”””ll I|IID]|]D] I_I_l'ﬂ_lih]]DI:IDI] Dl:[ﬂDDEIj il

Shigella flexneri 2a str. 2457T

There are 32 LCBs with minimum weight ﬁﬂﬁﬂbscherichia coli K12, complete genome. |3351BEB |LCB length: 7(

Figure 3 (above) shows the same alignment zoomed in on aregion 3.85Mbp into the E. coli K12 genome where the geneemrD is
encoded. Annotated genes are shown as white boxes, with genes transcribed from the reverse strand shifted downward. The mouse
cursor (shown as ablack line) is hovering over the emrD CDSin E. coli K12. The similarity plot for the N-terminal end of the gene
and the upstream region is colored brown, indicating that the segment of DNA is missing from the S. flexneri 2a 301 isolate. The
segmental deletion could potentially have consequences for gene regulation in this S, flexneri 2a 301.

Navigating the display

Zooming and shifting the display

The alignment display isinteractive, providing the ability to zoom in on particular regions and shift the display to the left and right.
Navigating through the alignment visualization can be accomplished by using the magnifying glass and arrow control buttons on
the toolbar immediately above the display. Alternatively, keyboard shortcuts allow rapid movement through the alignment display.
The keystrokes Ctrl+up arrow and Ctrl+down arrow zoom the display in and out, while Ctrl+left arrow and Ctrl+right arrow shift
left and right, respectively. Holding down the "shift" key with Ctrl+left and Ctrl+right accelerates the shifting leftward and
rightward.

M ouse control

When moving the mouse over the alignment display Mauve will highlight the aligned and homologous sites of each genome with a
black vertical bar. By clicking the mouse in the sequence similarity plot, Mauve will line up the orthologous sites of each genome.
Finally, aportion of the alignment can be selected by clicking and dragging over the similarity plot while holding down the "shift"

key.

Reordering sequences and changing the reference genome

When viewing alignments of many genomes, it is often desirable to reorder the genome sequences. This can be accomplished by
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clicking the up and down arrow buttons to the left of each genome. By default, Mauve uses the first genome sequence as the
reference genome for assigning a reference orientation to inverted blocks. The reference genome can be changed by clicking the
"R" button for the desired reference sequence, also to the left of the genome sequence display. The following figure shows the
alignment of three E. coli and Shigella after it has been reordered and the reference was changed:
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Hiding sequences

When viewing an alignment with alarge number of genome sequences, it can be helpful to simplify the view by restricting the
display to genomes of interest. This can be accomplished by clicking the minus button at the left of the display. For example, here
isaview of an aignment of 21 genomes, with many of them hidden from view.
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Searching for annotated features

Every good molecular biologist has afavorite gene. Since version 2.0.0, Mauve has a convenient interface to make finding your
favorite gene easy. Annotation can be searched by by gene name, product description, amino acid sequence, and other information.
The search feature can be activated by clicking on the binoculars button in the toolbar, or through the "View->Go To->Find
Features’ menu item. Mauve will then present a search interface window:
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In the present example, the alignment of three E. coli and Shigella has been searched for genes that encode products related to
penicillin. The search results for each genome are shown at right. A particular gene, dacC has been selected. When dacCis
clicked, the display refocuses itself onto the region surrounding the dacC gene, which is highlighted in light blue:
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Interestingly, the penicillin binding protein encoded by dacC appears to have been pseudogenized in the Shigella genomes.
Inspection of the surrounding region reveals two CDS annotated as | S600, awell known transposable element that has colonized
the Shigella. The 1S600 has inserted itself near the end of the dacC gene.

Creating publication quality graphics with Mauve

Although Mauve offers a means to export an image file of the current display, using the "File->Export Image..." menu item, the
exported images are raster graphics and may not beideal for journal publication. To create publication quality EPS or PDF
graphics with Mauve, it is better to print directly to a postscript file or aPDF. Thisis done by selecting "File->Print" and then
choosing a PDF or postscript output from the print dialog. On Mac OS X, thereis an option in the print dialog to " Save to PDF"
which can easily be used. Under Windows, there is no built in PDF renderer, although severa third-parties sell software with this
feature. Adobe Acrobat includes a PDF renderer, and companies such as FoxIt and pdf995 offer free PDF rendering software.
Another option isto use the "Print to file..." checkbox in the windows print dialog. If a postscript printer driver has been installed,
the resulting file will bein postscript (EPS) format. A postscript printer driver can beinstalled in Windows without actually
connecting areal printer, by going to the Printers control panel, and choosing "Add printer." Select a"local printer attached to this
computer” and do not "Automatically detect and install my Plug and Play printer". Click Next. Select "Use the following port" and
select "FILE: (Print to File)". Click Next. When prompted for a printer model, select Apple Color LW 12/660 PS. Click Next.
Choose a printer name and you're done.

Once a postscript or PDF file has been created, it is often desirable to edit the file. The best program to do so is Adabe Illustrator,
asit has been designed for editing vector graphics files such as postscript and PDF. Alternative graphics editing software such as
Xara Xtreme or the open-source Inkscape (version 0.46 or later contains PDF import) may be worth investigating.

While it may seem like a hassle to process Mauve images in vector formats like PDF or EPS, your effort will be rewarded with

crisp print quality that far exceeds agrainy and pixelated screenshot. Moreover, Mauve graphics in PDF or EPS format can be
scaled to print in large multi-page formats or on posters without loss of visual quality.
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Exporting sets of positionally orthologous features (genes, CDS, tRNA, and so on)

Beginning with version 2.3.0, Mauve has the ability to identify sets of positionally orthologous sequence features and export a list
of such annotated features. Annotated features can be CDS, gene, rRNA, tRNA, or misc_RNA. With an alignment generated by
progressiveM auve, the orthologs can be exported by selecting "Tools->Export->Export Positional Orthologs' from the menu. A
window will then appear requesting the location to save the ortholog output file(s) along with some configurable parameters for the
ortholog identification algorithm. One parameter is the permissible range of nucleotide identity for ortholog sequences. To be
called as orthologs, a pair of annotated features must have an average pairwise nucleotide identity within the specified range. The
nucleotide identity is calculated only over conserved regions shared by the pair of annotated features, not including large gaps. A
second parameter is the "coverage” of the pair of annotated featuresin the alignment. The coverageis calculated as the fraction of a
feature that is aligned to the other feature. If X% of the length of feature A isaligned to feature B, and Y % of the length of B is
aligned to feature A, and X and Y are both within the user-specified range of allowable coverage, then A and B will be considered
orthologous.

Once Mauve has identified all pairs of positionally orthologous featuresin the input genomes, it then applies transitivity to the
ortholog predictions. If A isfound homologousto B, and B to C, then A must also be homologousto C, even if A and C do not
meet the nucleotide identity or coverage requirements specified above. It has been argued in the literature that the evolutionary
relationship of orthology can not be applied transitively. Thisistruein general, and for this reason one should consider positionally
orthologous features inferred by Mauve as just that: inferences, which could be incorrect in some cases. Frequently homologous
genes located in the same chromosomal context will indeed be orthologs and so inference of additional orthologs by transitive
application of orthology will yield correct results. But occasionally evolutionary processes such as gene conversion with duplicate
gene copies may create a situation where the positional homolog is a paralog. For this reason we suggest that users of the ortholog
export feature exercise caution when interpreting the evolutionary history of positional orthologs generated by Mauve.

In addition to parameters controlling the orthol og inference procedure, the export window contains an option to output afile of

multiple alignments corresponding to each ortholog set. The/locus_tag qualifier of GenBank annotations is used to give hames for
orthologous features in the ortholog output files.

Keyboard control reference

Function Keystroke
Zoomin Ctrl + Up
Zoom out Ctrl + Down
Scroll display left Ctrl + Left
Scroll display right Ctrl + Right

Large left scroll

Largeright scroll

Open an existing alignment file
Print the current view

Set the page layout for printing
Export the current view as an image
Close the current alignment window
Quit Mauve

Show or hide LCB connecting lines
Show or hide LCB outlines

Other Color Schemes

When the "Full Alignment" option has been disabled, several color schemes become available. These color schemes are not
available when viewing afull alignment with asimilarity profile display.

LCB Color

Shift + Ctrl + Left
Shift + Ctrl + Right
Ctrl + O

Ctrl +P

Ctrl + Shift + P
Ctrl + E

Ctrl + W

Cirl +Q

Shift + L

q

Each locally collinear block (LCB) is assigned a unique color.

Multiplicity Color

Matches are colored differently based on their Multiplicity, where Multiplicity is defined as the number of matching genomes. e.g.
A match with multiplicity=5 indicates that 5 genomes contain that homologous region of sequence.
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Multiplicity Type Color

Matches are colored differently based on which genomes they match in, or their multiplicity type. For example, regions that match
in genomes A, B, and D would be colored differently than regions matching in B, C, and D, even though the matches have the same
multiplicity. The normalized version of multiplicity type color mode makes the colors used more distinguishable by eliminating
unused multiplicity types from the color palette.

Offset Color

Matches are colored based on their generalized offset. The generalized offset is a number that summarizes the relative positioning
of the match in each genome. Matches with similar generalized offsets will generally be collinear with each other. Thus regions of
potentia collinearity can be visualized using this color mode without actually performing LCB detection. This can be especially
useful when comparing alarge set of diverse genomes because the current implementation of LCB detection doesn't identify
rearranged regions that exist in only a subset of the genomes being aligned. With offset color, such regions will appear asa
continuously colored region in the Mauve viewer.
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Mauve Output File Formats

When a genome alignment is created, Mauve creates several output files containing data related to the alignment. Two of these
files, the .mauve and .alignment files actually contain the alignment in two different formats. The other files contain auxiliary
information such as the genome phylogenetic guide tree that was used for alignment, an identity matrix for the genomes, the
location of backbone -- regions conserved among all genomes, and the locations of islands -- regions where one or a subset of the
genomes has aunique seguence element.

The following sections describe the information contained by each of these files and their associated file formats.

The .alignment file and the XMFA file format

The .alignment file contains the complete genome alignment generated by Mauve in the eXtended Multi-FastA (XMFA) file
format. This standard file format is also used by other genome alignment systems that align sequences with rearrangements. The
XMFA file format supports the storage of several collinear sub-alignments, each separated with an = sign, that constitute asingle
genome alignment. Each sub-alignment consists of one FastA format sequence entry per genome where the entry's defline gives the
strand (orientation) and location in the genome of the sequence in the alignment.

The general structure of the file format as described by its author  (Michael Brudno) is as follows:

>seq_num start1l-endl + conments (sequence nane, etc.)
AC- TG NAG - TG
AC- TG NACTGTIG

> segq_num startN-endN = coments (sequence nane, etc.)
AC- TG NAG- - TG
AC- TG NACTGTG

= comments, and optional field-value pairs, i.e. score=12345

> seg_numstartl-endl £ comments (sequence nane, etc.)
AC- TG NAG- - TG
AC- TG NACTGTG

> seq_numstartN-endN + coments (sequence nane, etc.)
AC- TG NAG - TG
AC- TG NACTGTIG

= comments, and optional field-value pairs, i.e. score=12345

Non-standard XMFA formatting used by the Mauve GUI

The Java-based Mauve alignment viewer requires some non-standard formatting of the XMFA filein order to display it. Most
importantly, the Mauve viewer reguires that every nucleotide of the input genome sequences be recorded exactly oncein the
XMFA file. Thus, nucleotidesin one genome can not to multiple sitesin a second genome. For segments of a genome that did not
align and were outside L CBs, these segments most be given as ungapped singleton entriesin the XMFA:

> seq_num startN-endN = coments
ACTCAGGTITATCG. . .

A second non-standard formatting requirement is that the first LCB entry in the XMFA list all input genome sequences, even if they
did not alignin that LCB. Genomes that have no sequence in that LCB are given using 0-0 as the coordinate range. For example,
in an alignment of four genomes where only two were aligned in the first LCB, theinitial LCB might look like:

> 1:0-0 +
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>2:1-377 +
ACGA- - - TAAAATTCCC. . .

>3:1-422 -
ACTACCCTACAATTGCLC. . .

>4:0-0 +

The Mauve alignment file format

The .mauve or .min file aso contains a representation of the genome alignment. Instead of including every aligned nucleotide asin
the XMFA format, the Mauve alignment format stores the coordinates of large exactly matching regions to save space. For similar
genomes the Mauve alignment format saves a significant amount of disk space over the XMFA format.

The mauve alignment format begins with a single line stating the revision of the file format, followed by several lines describing
the sequences that were aligned. Using the alignment of three Salmonella genomes as an example:

For mat Ver si on 4

SequenceCount 3

SequenceOFi | e D: S typhi.fas
SequenceOLengt h 4809037

SequencelFil e D: S typhi 2. fas
Sequencellengt h 4791961

Sequence2Fil e D: S_typhimuriumfas
Sequence2lengt h 4857432

I nt er val Count 69

Currently Mauve uses version 4 of its alignment file format. The next line contains the token SequenceCount which is used to
specify the number of sequences aligned. Two lines are then given for each sequence, the first specifying the location of the original
sequence file and the second specifying the sequence length in nucleotides. The final line contains the token Interval Count which
specifies the number of locally collinear blocks that were found among the aligned genomes.

The remainder of the file contains anumber of Interval definitions, each of which specifies an LCB-- one collinear region of
aligned sequence. Together, these LCBs make up a complete genome alignment with rearrangements. Here is an example interval
definition:

Interval 3

153 292618 -2687311 294793
GappedAl i gnnent

7 292771 -2687304 294946
GCCTGCG

GCCTGCG

CCATGTC

53 292778 -2687251 294953
GappedAl i gnment

1 292831 -2687250 295006
A

A

G

127 292832 -2687123 295007

Each LCB beginswith an Interval token specifying the relative position of the LCB within the first genome aligned (the reference
genome). Subsequent lines specify the actual alignment. When constructing an alignment, Mauve chooses a set of multi-MUMs
(exactly matching regions present in each genome aligned) to anchor its alignment with. Each Interval definition records the
position of these multi-MUM anchors in addition to alignments of the regions between anchors that were calculated using
Clustal-W. In the example above, the line 153 292618 -2687311 294793 records amulti-MUM of length 153, with aleft-end at
292,618in S _typhi, on the opposite strand at position 2,687,311 in S_typhi2, and at 294,793 in S_typhimurium.

The next 5 lines in the example above give an alignment of inexactly matching sequence generated by ClustalW. The token
Clustal Result indicates that the following lines belong to such an alignment. The next line gives the total length of the (possibly
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gapped) alignment and the left-end of the Clustal alignment in each genome. Finally, the next three lines (one per sequence aligned)
record the actua aignment.

Each Interval records one or more of the multi-MUM and Clustal alignment entries which, when strung together, can specify a
complete alignment over the region spanned by the LCB.

Theidandsfile

The .idands file contains a tab-delimited text listing of genomic islands found in the alignment. Each island represents a region of
the alignment where one or more genomes have a sequence element that one or more others lack. In the current Mauve
implementation, an island is defined by the genome coordinates of one sequence where another genome contains a gap of length n
or longer in that part of the alignment. The length of gaps that constitute islands can be set with the Minimum Island Size field of
the Align sequences dialog box. For example, if n was defined as 5 for the following alignment:

Genome 0: ACACGTTCGCTTCGAAA
Genome 1. ACAG- - - - - - TTCGAA-
Genome 2: ATACGATCGCTTCGTAA

We would say that genomes 0 and 2 have an island at positions 5 though 10. Each line of the .islands file records asingleisland in
the form: GenomeA # <tab> |eftA <tab> rightA <tab> GenomeB # <tab> |eftB <tab> rightB. So in the .idandsfile, our example
islands would be recorded as:

0 4 11 1 4 5
1 4 5 2 4 11

Thefirst line records that in Genome #0 nucleotides 4 through 11 align with nucleotides 4 though 5 in Genome #1. Similarly, the
second line records that nucleotides 4 and 5 of Genome #1 align with nucleotides 4 through 11 of Genome #2. In both cases the
island length is 6 and can be calculated as absolute((rightA - leftA) - (rightB - |eftB)). Note that negative left and right values
indicate the inverse orientation (the opposite strand).

The origina Mauve backbonefile

The .backbone file records regions of the alignment where sequenceis conserved among all of the genomes being aligned. The
current Mauve implementation defines a conserved region as an area of the alignment at least X nucleotides long that contains no
gaps as long or longer than y nucleotides. When using the Align sequences window to perform an alignment, the values of x and y
are fixed to the minimum island size. These values can be set explicitly using the command-line mauveAligner application.

Each line of the .backbone file records a single conserved segment. Left and right end coordinates of the conserved segment are
given for each genome sequence. For example, the line:

22256 22371 20147 20299 22255 22370
Would indicate that nucleotides 22,256 through 22,371 from the first genome are conserved in the second and third genomes from

20,145 through 20,299, and 22,255 through 22,370 respectively. Two entries exist per genome, and each entry is tab-delimited.
Negative valued coordinates indicate an inverted region (on the opposite strand).

The Progressive Mauve backbone file

Progressive Mauve utilizes a revised backbone file format which reflects its ability to align regions conserved among subsets of the
genomes under study. A short example of the backbone file format is:

seq_0O_leftend seq O _rightend seq_1 leftend seq_1 rightend seq_2 leftend seq_2 rightend

1 15378 1 15377 1 15377
16728 19795 15378 18446 15378 18445
0 0 18447 18668 18446 18667
19796 20566 18669 19439 18668 19438

Thefirst lineis aheader line, indicating the information contained by each column. Each subsequent line corresponds to a segment
of DNA conserved among two or more genomes. Thus, thefirst line indicates that the segment between coordinates 1 and 15378 in
the first genome is homol ogous to the segment between coordinates 1 and 15377 of the second and third genomes. Similarly, the
second line indicates that the segment [16728-19795] in the first genome is homologous to [15378-18446] in the second genome
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and [15378-18445] in the third genome.

Anisland exists in the first genome between [15379-16727], and its existence is given in the backbone file as alack of any line
containing that segment. The seq_0_rightend column skips from 15378 on line 1 to 16728 on line two. By default, the rows of the
backbone file are sorted on the seq_0_leftend column (absolute value). To infer islands in seq 0, we can thus simply compare the
rightend of one line to the leftend from the subsequent line. The data can betrivially processed to observe islandsin other genomes
using a spreadsheet program like OpenOffice Calc or MS Excel. Simply sort the rows on the absol ute value of the column for a
sequence (e.g. seq_2_leftend) and then compare right-end to left-end on the subsequent line.

Anisland (or subset backbone) also exists in the second and third genomes. The existence of the subset backbone is given on the

third line, where seq_0_leftend and seq_0_rightend both have zero values to indicate that the first genome lacks any detectable
homology to the segments [18447-18668] in the second genome and [18446-18667] in the third genome.

The guide treefile

The guide tree is the standard Newick tree file format. A decent description of the Newick tree file format can be read here:
http://evol ution.genetics.washington.edu/phylip/newicktree.html

The identity matrix file

Thisistab-delimited text where rows and columns are genomes in the order input to the aligner. Identity scores range between 0
and 1, where O indicates that no identical homologous nucleotides were found, and 1 indicates that every homologous nuclectide
was identical.

The permutation matrix file

Thisis atab-delimited text file that records the order and orientation that each LCB occurs in the aligned genomes. The
permutation matrix file can be used to infer phylogenetic rearrangement history using tools such as BADGER, GRAPPA, MGR,
and others. Thisfileis generated by adding the command-line option --permutation-matrix-output=<filename> when running
mauveAligner. An example of afile with three genomes and seven LCBsfollows:

0 1 2 3 4 5 6
1 2 3 -6 -5 -4 0
0 1 2 3 -6 -5 -4

Each genome is recorded on a single line, with lines ordered according to the order of input genomes. The LCB arrangements are
recorded on each line, with the first genome used as a reference genome to assign numeric identifiersto LCBs. A minussign (-)
indicates that a block isinverted relative to the reference genome.

The LCB boundary file

Thisis another tab-delimited file that complements the permutation matrix file with information about the LCB boundaries. This
file can be used, for example, to derive the lengths of blocks and by extension, the lengths of genome rearrangements predicted by a
rearrangement history reconstruction algorithm. An example of the file format for three genomes follows:

#seqO0_l eftend seqO_rightend seql_leftend seql_rightend seq2_leftend seq2_rightend

1 11936 250 14147 1 11951
13856 54361 16067 56756 - 3398531 - 3439222
57092 120151 3854873 3917932 -41024 -106027

Thefile starts with a header line defining the content of each column. Each subsequent row defines the left- and right-side LCB
boundaries for one LCB. Thus, the first row indicates that nucleotides 1-11936 from genome O correspond to nucleotides
250-14147 from genome 1 and nucleotides 1-11951 from genome 2.

The SNPfile

This tab-delimited file can be created from alignments using Mauve version 2.3.0 and later. For every polymorphic sitein an
alignment, the SNP file records the nucleotides present in each genome at that site, along with the sequence coordinates of the site
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in each genome. An example on three genomesis as follows:

SNP pattern sequence_1 sequence_2 sequence_3
AAT 5276590 5246627 394
TTC 5276784 5246821 588
AAC 5277418 5247455 1222
MAA 5278225 5248262 2030
AAC 5282804 5252841 6609

The first column lists the SNP pattern with sequences ordered the same as when input for alignment. The top of the XMFA file can
be used as areference for sequence filenames. Each subsequent column contains coordinates for each of the genomesin turn. Thus
each line lists a SNP pattern and the location of that SNP in each genome. Note that [UPAC nucleotide ambiguity codes are
considered as possible SNPs -- hence the M in the fourth example SNP above.

The orthologsfile

The orthologs file is a tab-delimited file that can be created from progressiveMauve alignments using Mauve version 2.3.0 and
later. The ortholog file lists groups of annotated and unannotated genes that are predicted to be positionally orthologous by
whole-genome multiple alignment. Each row in the file lists a group of orthologous genes, along with the index of the genome from
which the gene derives, the name of the gene (if given in the annotation file) and its sequence coordinates in the global coordinate
system of that genome. Entries within aline are tab-delmited and colon-delimited. An example for 4 genomes follows:

0: Z03: 2818- 3750
0: Z04: 3751- 5037
0: Z05: 5251- 5547
0: Z06: 5700- 6476

:c04: 3512- 4444 2::2801-3733 3: ECSE_03: 2800- 3732

:c05:4445-5731 2::3734-5020 3: ECSE_04: 3733-5019

:c07:5945-6241 1:c08:6021-6269 2::5234-5530 3: ECSE_05: 5233- 5529
:¢10: 6301- 7077 3: ECSE_06: 5682- 6458

e el o

Thefirst line lists agroup of four orthologous genes, with one gene coming from each genome. In the first entry

0: Z03: 2818- 3750, the leading O refers to the genome's index, with indices assigned in the order the genomes were input for
alignment. Thus genome O isthe first genome, 1 isthe second, and so on. The next part, Z03, refersto the locus tag identifier for
the annotated gene. The third colon-delimited part refers to the coordinate range of the annotated gene. The remainder of the line
lists out genesin the other three genomes found to be positionally orthologous. In the case of genome 2 we have an entry
2::2801-3733. In this case there was no gene annotated in the region, but aregion was found to be positionally orthologous, and so
the coordinates of that region are listed without alocus_tag.

The third line in the example highlights a situation where multiple annotated genes in one genome are found to be orthologousto a
single gene in other genomes. In this case, two overlapping genes were annotated in genome 1, and each of those genes
individually was predicted to be positionally orthologous to the corresponding genesin other genomes. Since they overlap and are
orthologous to the same genes in other genomes, they are considered a group of positional orthologs. Thus, any group of positional
orthologs may contain multiple genes from a single genome.

The fourth line in the example illustrates the situation where one of the genomes does not have a positional ortholog of the genes.
In this case, genome 2 lacks a region predicted to be positionally orthologous.
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Reordering contigs in draft genomes
When to use Mauve Contig Mover (MCM)

The Mauve Contig Mover (MCM) can be used to order a draft genome relative to arelated reference genome. The functionality of
this software module has been described in Rissman et al. 2009 , a publication in Bioinformatics. The Mauve Contig Mover can
ease a comparative study between draft and reference sequences by ordering draft contigs according to the reference genome. In
many cases, true rearrangements in the draft relative to the reference can be identified. The quality of the reorder islimited by the
distance between the sequences, as indicated by the amount of shared gene content among the two organisms. A more distant
reference will usually yield fewer ordered draft genome contigs, and may also induce erroneous placements of draft contigs. In
addition to ordering contigs, MCM also orient them in the most likely orientation, and, if annotated sequence features are specified
inaninput file (e.g. with GenBank format input for the draft), MCM will output adjusted coordinates ranges for the features.

Using Mauve Contig Mover

Mauve Contig Mover can be launched from the Tools->Order Contigs Menu of The Mauve Viewer.
(& Mauve 2.3.0_ beta - Genome Alignment Visualhization

File View [Tools| Help

Move Contigs

et

Eﬂrder contigs of draft genume|

Once the Mauve Contig Mover has been launched, it starts by requesting the user to specify an output directory. MCM will create a
series of mauve alignments in the output directory, structured into several subfolders, so creating a new, empty output folder is
often best to minimize clutter. The output directory selection is shown below.
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Choose location to keep output files and folders.

Look In: | koadman - E

] bin IR

] data ] remotefs
] Desktop ] reordering
3 development[—] resumedata
] Documents [ software
Jinclude CJtmp

3 lib CJ workspace
3 public_htmil

File MName: |jhnme;Iquadman;renrdering |

Files of Type: |All Files |

0K H Cancel |

Once the output directory has been set, awindow similar to the Progressive Mauve Alignment Window appears. Using the
Progressive Mauve alignment window is described in more detail in the section " Constructing a genome alignment ", but when
used for reordering contigs, the following additional notes and constraints apply:

1. Only two sequences should be entered. The first 